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WELCOME TO SHAPE BUILDING!

EASY DESIGN ON DEMAND!
Do you ever think you don’t have the tools or 
skills to make custom shape designs for your 
PowerPoint slides? Think you need fancy or 
expensive software or advanced design skills?

Believe it or not, you already have
everything you need to get started!

With a little creativity, this step - by - step guide 
will teach you how to build custom shapes in 
PowerPoint that will not only spice up your 
PowerPoint slides but also help you create
more compelling visuals, charts, and diagrams.

You can use these shapes for a number of
items, including but not limited to:

▶ Custom icons
▶ Image shape cut - outs
▶ Custom image cropping
▶ Other custom shapes for:

Infographics Visual 
Metaphors for 
Processes or 

Pipelines

Timeline 
Markers

KPI Gauges Workflow 
Visuals & 

Swimlanes

THE LIST IS ENDLESS!
Let’s dive in and show you how you can use shapes

to design more engaging and powerful slides!
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TABLE OF CONTENTS

WHAT’S INSIDE THIS GUIDE
Use the Table of Contents below to navigate this guide.

If you’re viewing this guide on a computer , y ou
can select any item to navigate there directly.

NOTE :
This may  not  
function on a 
smartphone 
or tablet.
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SECTION 1: MAKING &
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LET’S CIRCLE BACK TO THE BASICS
Before anything else, let’s start with the basics to make sure everyone is on 
the same page – making and manipulating a shape.

1. There are two ways to add a shape: from the Home tab and from the 
Insert tab. Let’s take a look  at both.

A. ADD A SHAPE FROM THE HOME TAB

i. Locate the Drawing section of the Home tab.

ii. Choose the shape you want to draw from the
Shapes dropdown menu .

1Aii.

1Ai.

B. ADD A SHAPE FROM THE INSERT TAB

i. Locate the Illustrations section of the Insert tab.

ii. Choose the shape you want to draw from the
Shapes dropdown menu .

1Bi.

1Bii.

F76B1C
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2. Once you choose a shape, you will see that your
cursor has changed to crosshairs . Click anywhere
on the slide and hold down the mouse or trackpad.

3. Drag your mouse or trackpad to draw the shape.
The farther you drag, the larger the shape will be.

2.
3.

4. Optionally, you can hold down the Shift key while dragging the mouse 
or trackpad. This will lock the dimensions of the shape to a 1:1 ratio – 
for instance, to create a perfect square or a perfect circle.

+   Drag

?

??

1

1

F76B1C

Button - Return to the Table of Contents.
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5. When you’re happy with your shape, release
the mouse . Don’t worry about getting it perfect
on the first try – you can modify your shape later!

F76B1C

6. If you want to manipulate the size, dimensions, rotation, location, or 
formatting of your shape, click it once to highlight it .

TIP: WHAT’S THAT THING AROUND MY SHAPE?
When you select a shape, you will see a rectangular

border appear around it with eight equal points.

This is called a bounding box . It lets you see very clearly 
which shape(s) you have selected at a given time.

Even more important than this, though – it also allows
you to manipulate the shape, as listed in steps 6 - 10.

7. To change the size or dimensions of the shape, click and hold any of 
the eight points of the bounding box. Then, drag in the direction you 
want the shape to change.

7.

8. Optionally, you can hold the Shift key to make it larger or smaller 
while keeping the shape’s current dimensions.

Button - Return to the Table of Contents.
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9. To rotate the shape, click and hold 
the rotation icon  connected to the 
shape’s bounding box. Then, move 
your mouse  in the direction you 
want the rotation to go.

F76B1C

10. To move the shape while keeping its 
current shape and size, click and 
hold anywhere inside  the shape or 
the edge lines of the bounding box 
(NOT the eight points). Then, drag 
the shape to the desired location.

9.

10.

11. You will notice that shapes will automatically line up to other shapes 
using invisible guides. This is called snapping .

These guides become visible as you drag the shape when it begins
to line up with other items on the slide or even with the slide itself.

If you don’t  want the shape to line up with  these
guides,  hold the Alt/Option key while moving the shape.

Button - Return to the Table of Contents.
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12. Once your shape has the size, dimensions,
rotation, and placement that you want, simply
click any blank space on the slide to deselect the shape.

F76B1C

13. Some shapes, such as parallelograms and stars, have additional 
manipulation options  that appear in the bounding box. These are 
denoted by an additional ninth point inside the bounding box.

A. In the case of the parallelogram , by clicking and dragging this point 
side to side, you can change the steepness of the angled edges.

B. In the case of a star , by clicking and dragging this point up and 
down, you can change the thickness of the arms of the star.

C. Steps 13a and 13b are just examples – any time you see these 
additional points, drag them around to experiment and see what 
they do! If you ever don’t like the changes you made, simply use
the keyboard shortcut Ctrl+Z/Cmd+Z to undo the change.

13A. 13B.

AND THAT’S IT!
Remember that just because you’ve 

deselected the shape doesn’t mean you can’t 
select it again later to manipulate it further.

Button - Return to the Table of Contents.
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YOUR TURN! MAKE A SHAPE
Follow the steps below to practice making and placing a shape.

1. Open a new PowerPoint 
presentation.

2. Add a shape both from the 
Drawing section of the Home tab 
and from the Illustrations section 
of the Insert tab (step 1).

3. Make one shape locked to a 1:1 
ratio by holding the Shift key while 
dragging and one shape not locked 
to a specific ratio (steps 3 - 4).

4. After creating a shape, manipulate 
it using the eight points and 
rotation icon of the bounding box 
(steps 6 - 9).

5. Move the shape to another 
location on the slide (step 10).

6. Create a second shape and line it
up with the first by snapping  it to the invisible guides (step 11).

7. Create a star or parallelogram and manipulate its ninth yellow point (step 13).

YOU’LL BE A SHAPES PRO BEFORE YOU KNOW IT!

Button - Return to the Table of Contents.
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REFLECT ON WHAT YOU LEARNED

How can you apply what you learned in this section? Write 2 - 3 ideas.

What are some of your key takeaways from this section? Write any notes or 
tips you want to remember and any other thoughts from this section.

What are you struggling with or confused about? Record any questions you 
have about this section.

Button - Return to the Table of Contents.
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IT’S SHAPING UP TO LOOK PRETTY GOOD!
Now that you’ve got your shape where you want it, as well as the correct 
size, dimensions, and rotation, it’s time to start thinking about the formatting 
– namely, the colors and any special effects the shape might have.

A NOTE BEFORE WE GET STARTED
Keep in mind that in many organizations, the colors you can choose 

from may be predetermined  by your company’s brand guidelines.

Some companies have these colors built into their PowerPoint 
templates, which you may even be using right now!

But if not, you can search your company’s intranet page
to see if the brand guidelines have been posted, or if not,

you can contact your Marketing team for further assistance.

This is especially important if you’re making
a presentation for a large audience, senior leadership,
or that  will be viewed externally outside the company .

1. Click the shape to select it.

F76B1C

NOTE
T he shape will be 

selected when the 
bounding box – or the 

rectangular border 
with eight points – 
appears around it.

Button - Return to the Table of Contents.
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2. There are two ways to change the formatting
of a shape. Let’s take a look  at them both.

A. USING THE SHAPE FORMAT TAB

i. After you click the shape,
click the new tab that appears
on the toolbar called Shape Format .
The tab may automatically open
upon clicking the shape.

Shape Is 
Selected

NOTE
This tab only

appears when a
shape is selected.

If you aren’t seeing 
this tab, it means
you either haven’t 

selected your shape 
per Step 1, or you have 

selected a different 
item by mistake,

such as an image.

B. USING THE FORMAT SHAPE PANEL

i.  Right - click the shape you want to format.

ii. From the dropdown menu that appears, choose Format Shape .

iii. The Format Shape panel will open on the right - hand side of your 
screen. Often, the Fill & Line button , denoted by a paint can, will 
be selected by default, but if it isn’t, you can click it now.

Right-
Click 2Biii.

2Bi.

2Bii.

Button - Return to the Table of Contents.
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FOR THE PURPOSES OF THIS GUIDE…
We will talk about how to format shapes from the Format Shape panel , 

per step 2B on the previous page, as there are additional options 
available there that aren’t available from the Shape Format tab.

3. You will see several options for changing the formatting of your shape. 
For the purposes of this guide, we’re going to focus on these three in 
the following steps: Shape Fill , Shape Outline , and Shape Effects .

4. SHAPE FILL
Shape Fill refers to the color of the shape itself. You have a number of  
options for how you can fill the shape.

A. NO FILL: You can take away the 
color of the shape entirely, making 
it fully transparent . To do so, click 
the No Fill radio button .

4A.B. FILL WITH A COLOR

i. First, choose the Solid Fill 
radio button .

ii. Then, you can choose a 
solid color from the menu 
of colors provided.

iii. You can also change how 
translucent or opaque the 
shape is by using the 
Transparency slider .

4Bi.

4Biii.

4Bii.

Button - Return to the Table of Contents.
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iv. You aren’t limited to only 
the colors listed in the 
Color menu. When you click 
the Color menu dropdown , 
you have the option to 
choose any custom color 
you want from the More 
Colors panel .

v. Click and drag anywhere in 
the rainbow to choose a 
custom color and use the 
slider to make the color 
lighter or darker.

vi. If your company provides 
branded colors, enter the 
RGB  (Red, Green, Blue) 
numbers or 6 - digit hex 
code  here.

4Biv.

4Bv.

4Bv.
4Bvi.

iv. You’ll notice as you choose custom colors that they 
will appear in the Recent Colors row beneath the 
color menu. This makes it easy to pick the same 
colors again once you’ve chosen them  the first time.

Button - Return to the Table of Contents.
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C. FILL WITH THE EYEDROPPER: To 
match the color of the shape to 
another item on your slide, use 
the Eyedropper tool available in 
the Solid Fill section. With the 
Eyedropper selected, click the 
color on another item on your 
slide and watch the shape fill
with the exact same shade!
This is great if you want to
match a shape to an exact
color on an image.

Anything you want to color - match must
be on the slide with the shape. For instance, if you want to use a color from a 
picture on a webpage, you must first insert it into your slide.

D. FILL WITH A GRADIENT: To fill the
shape with more than one color,
select the Gradient Fill radio button .
You can choose from the list of
premade gradients or make your own.

i. Use the slider  to place your Gradient 
Stops (where each color will start).

ii. You can change the color of each 
Stop marker with the Color 
dropdown, as well as toggle the 
transparency of each item.

iii. You can modify  the type of  gradient 
(Linear, Radial, etc.), the direction
of the gradient, and the angle.

©2025 - 11.21, Vectora  Enterprise
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4Dii.
4Di.

4Diii.

Button - Return to the Table of Contents.
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E. FILL WITH A PICTURE OR TEXTURE: 
To fill the shape with an image or 
texture, choose the Picture or 
Texture Fill radio button .

i. You can insert a picture using 
the Insert button .

ii. A popup menu will appear 
asking you where on the 
computer you want the picture 
to come from. You can choose
a picture from a File on your 
computer, from a free Stock 
image library in PowerPoint, 
and more!

©2025 - 11.21, Vectora  Enterprise
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iii. Alternatively, you can
choose a premade texture
from the Texture dropdown menu .

4Ei.

4Eiii.

4Eii.

F. FILL WITH A PATTERN: To fill the shape with 
a pattern, choose the
Pattern Fill radio
button . You can
choose from a number
of patterns and change
the foreground and
background colors.

4F.

Button - Return to the Table of Contents.
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G. TO MATCH THE FILL OF THE SHAPE TO 
THE BACKGROUND: Choose the Slide 
Background Fill radio button to change 
the color of the shape to match the color 
of the slide’s background.
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5. SHAPE OUTLINE
Shape Outline refers to the outline of the shape. You have a few options 
for the shape outline.

A. TO REMOVE THE OUTLINE ENTIRELY: 
You can choose for your shape to have 
no outline at all by clicking the
No Line radio button .

B. TO CREATE A SOLID OUTLINE: A “solid” outline simply 
refers to the color of the outline – that the outline will be 
only one solid color, as opposed to a gradient of colors.

CAN ALL BE EITHER SOLID OR GRADIENT OUTLINES

STANDARD 
LINES

DOTTED
LINES

DASHED
LINES

COMPOUND 
LINES

SKETCHED 
LINES

Button - Return to the Table of Contents.
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i. Start by choosing the Solid Line 
radio button .

ii. Then, choose the color  and 
transparency  for the line.

iii. You can increase the line 
thickness using the Width ticker .

iv. You can make dotted and dashed 
lines by choosing from the Dash 
Type dropdown menu .

v. To make dots round
or squared, change
the  Cap Type to
round or  flat,
respectively.

vi. Play with all the
other  options
available to  create unique effects!

5Bi.

5Bii.

5Biii.

5Biv.

5Bv.

C. TO CREATE A GRADIENT OUTLINE:
A gradient outline has all the same 
styling options as a solid outline 
except that it allows you to have
more than one color across the line.

i. Start by choosing the Gradient 
Line radio button.

ii. Just like with the gradient fill, use 
the Stop markers to determine 
where each
color begins.

5Ci.

5Cii.

Button - Return to the Table of Contents.
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6. SHAPE EFFECTS
You can add all sorts of effects to a shape to
give it different properties that make it stand
out from the slide, appear to be
highlighted , stylize  it, or otherwise
draw attention to it. Let’s look at
what’s available in PowerPoint.

To access all the Shape Effects
options, click the Effects button
in the Format Shape panel under the Shape Options.

6.

A. ADD A SHADOW: A shadow can give 
a shape the illusion of being three -
dimensional or appear to be jumping 
off the page.

i. To add a shadow, choose  the 
option from the Presets 
dropdown  menu that best  
matches the look you want.

ii. Once you choose, you can 
change the color of the shadow, 
how transparent  or opaque the 
shadow is, its size , how blurred  
or sharp it is, its angle , and how 
far  it is from the shape.

6Aii.

6Ai.

Button - Return to the Table of Contents.
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B. ADD A REFLECTION: A reflection can give
a polished or high - tech effect to a slide, 
making it appear as though a shape is sitting 
on a shiny surface like glass or marble.

i. To add a reflection, choose the option 
from the Presets dropdown  menu that 
best  matches  the look you want.
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ii. Then, change how transparent  or opaque the reflection is, how far 
down the reflection goes, how blurred  or clear the reflection is, and 
the distance  the reflection is from the bottom of the shape.

6Bi.

6Bii.

C. ADD A GLOW: A glow can highlight a
shape or make it appear as though the 
shape is emitting light.

i. To add a glow, choose the option
from the Presets dropdown menu
that best matches the look you want.

ii. You can change the color  of the glow, how widely the glow emits  
from behind the shape, and how transparent  or opaque it is.

6Ci.

6Cii.

Button - Return to the Table of Contents.
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D. SOFTEN THE EDGES: The Soft
Edges option softens the perimeter
of a shape by gradually fading its 
edges into transparency. It creates
a smooth transition with the items 
behind the shape while leaving the 
dimensions of the shape intact.

i. Start by choosing the option from 
the Presets dropdown menu that 
best matches the look you want.

D9DEE2

FFFFFF

F76B1Cii. Then, change how far into the shape the transparency reaches.

6Di.

6Dii.

E. 3 - D FORMAT & 3 - D 
ROTATION: While they don’t 
have to be used together, 
the two items tend to go 
hand - in- hand . Both add 
elements like beveling , 
lighting  effects, material  
effects, and rotation  
effects that make the 2 - D 
shape in the slide appear 
more three - dimensional.

TO WRAP UP:  Combining different
effects can turn any boring shape into something special! Experiment 
with all the different options available to see what you can create!

Button - Return to the Table of Contents.
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YOUR TURN! FORMAT A SHAPE
Follow the steps below to practice formatting a shape.

1. Open a new PowerPoint 
presentation and create a shape.

2. Open the Shape Format tab in the 
toolbar and the Format Shape 
panel (step 2).

3. Change the shape fill in at least 
three different ways – e.g., fill with 
a color, fill with a gradient, fill with 
a picture (step 4).

4. Change the shape outline in at 
least two different ways – e.g., 
create a solid line, change the 
solid line to dashed or dotted, 
create a gradient line (step 5).

5. Add at least three different types
of shape effects – e.g., add a
shadow, add a reflection, add a glow, 
experiment with 3 - D options (step 6).

YOU’LL BE A SHAPES PRO BEFORE YOU KNOW IT!

Button - Return to the Table of Contents.



©2025 - 11.21, Vectora  Enterprise
FOR INTERNAL USE ONLY – DO NOT SHARE WITH CUSTOMERS .
Phoenix Learning Solutions, LLC

25

SECTION 2: FORMATTING A SHAPE

0E616F

A3E635

2A2E32

D9DEE2

FFFFFF

F76B1C

REFLECT ON WHAT YOU LEARNED

How can you apply what you learned in this section? Write 2 - 3 ideas.

What are some of your key takeaways from this section? Write any notes or 
tips you want to remember and any other thoughts from this section.

What are you struggling with or confused about? Record any questions you 
have about this section.

Button - Return to the Table of Contents.
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THINK OUTSIDE THE BOX!
You aren’t stuck using only the premade shapes PowerPoint has in their 
Shapes dropdown menu. There may be times where you want to create 
either a curve or a geometric shape.

Let’s look at how to do both.

1.

F76B1C

MAKING A CUSTOM CURVE
A. In the Shapes menu, choose the Curve tool .

B. On the slide, click  where you want the  curve to begin .

C. Each click will denote where the  peaks and troughs of each curve 
will be. When you click the first time to begin drawing the curve, 
you’ll see that it appears to begin a straight line .

Button - Return to the Table of Contents.
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D. Move your cursor up to make a peak and down
to make a trough. Then, click where you want the
point . The line being drawn will automatically change to a curve.

E. Continue clicking to make a curve with several points, or you can
stop after just one or two clicks depending on your desired outcome.

Each Click Is a Peak or Trough
1E.

F. When you’re finished making your curve, hit the Esc key on the 
keyboard to finalize the shape. A bounding box will appear around 
the shape, signaling that the creation of the shape is complete.

to End Shape…
…& bounding 
box appears
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2. MAKING A CUSTOM GEOMETRIC SHAPE
A. In the Shapes menu, choose the Freeform: Shape tool .

F76B1C

B. On the slide, click where you want to put the first point of the shape.

C. Each click will create a point in the shape. Continue clicking to make
a geometric shape with several points.

Each Click 
Is a Point
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D. To lock any segment to 45 °  increments – including perfectly 
vertical, horizontal, or diagonal lines – hold the Shift key before 
clicking . You will see the line lock  in the direction you’re dragging it.

`

E. When you’re finished making your shape, you can create a fully 
closed shape by returning to the first point and placing your last 
point in the same spot . If you want to leave the shape open, you 
can hit the Esc key to finalize the shape at any time.

First & Last 
Point Are 
the Same

If you don’t like where the points are of your curve or geometric shape, 
don’t worry! In the next Section, we’ll discuss how to edit your custom 

shape, as well as any others you make from the Shape menu.
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YOUR TURN! HAND-DRAW A CUSTOM SHAPE
Follow the steps below to practice hand - drawing custom shapes.

1. Open a new PowerPoint 
presentation.

2. Use the Curve tool to make a 
custom curve. Make two different 
curves: one with only one bend 
and one with several peaks and 
troughs (step 1).

3. Use the Freeform: Shape tool to 
create a geometric shape. Make 
two different shapes: one where 
all the segments are locked to 
45 °  angles (perfectly straight, 
horizontal, and diagonal) and 
one where they are all freeform 
lines (step 2).

4. Create two new shapes, either
curves or geometric shapes. For
one, make a few points, then hit
the Esc key to finalize the shape without closing it. For the other, place 
the last point over the first point to close the shape (step 2E).

YOU’LL BE A SHAPES PRO BEFORE YOU KNOW IT!
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REFLECT ON WHAT YOU LEARNED

How can you apply what you learned in this section? Write 2 - 3 ideas.

What are some of your key takeaways from this section? Write any notes or 
tips you want to remember and any other thoughts from this section.

What are you struggling with or confused about? Record any questions you 
have about this section.
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GET TO THE POINT!
Perhaps you made a custom shape but don’t love how it turned out. Or 
maybe you made a pre - formed shape from the Shapes menu but need to 
adjust one or two of its points to make a new shape.

PowerPoint has a built - in shape editor that allows you to modify a shape 
point by point – not the points of the bounding box but the vertices or curves 
of the shape itself.

1. Start by selecting the shape you want to edit. Remember, when a 
shape is selected, you will see a bounding box around it.

F76B1C

2. The Shape Format tab will appear in the top toolbar. Usually, it will 
automatically open when you first select the shape. If it doesn’t, click 
the Shape Format tab to open it.

1.

2.

NOTE
This tab only appears when a shape is selected. If 

you aren’t seeing this tab, it means you either haven’t 
selected your shape per step 1, or you’ve selected a 

different item by mistake, such as an image.
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3. In the Insert Shapes section, click the Edit
Shape dropdown menu .

4. From here, you can use the Change Shape menu to turn the current 
shape into any other pre - formed shape.

5. For this example, though, let’s click the Edit Points option , which will 
allow us to do freeform editing.

3.

4.

5.

6. You will see that the bounding box around the shape has disappeared. 
In its place, the shape’s edges have each been highlighted , and new 
editable points have appeared at each of the shape’s vertices. These 
are called edit points or anchor points. You may also hear Bezier points, 
which refer to the points at the peaks and troughs of curves. In this 
guide, we’ll call them edit points.

Edit 
Points
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7. To edit the shape, click any one of 
the edit points  once to highlight it. 
When you highlight it, two more 
points will appear nearby. These 
new points are each handles on 
the lever that appears.

New 
Handles

8. From here, you have two options:

A. You can click and drag the edit point to place that point elsewhere.

B. You can click and drag one of the two new points to turn this point 
into a curve  (or edit the curve if it already is one). Each of these points 
is the handle of the lever, which pulls the line into a convex position or 
pushes it into a concave one. To make the curve even smoother, you 
can click the next edit point in line and adjust its levers, too.

8A. 8B.

9. Once you’re happy with the changes to your shape, click any blank area 
of the slide  to deselect the shape.

You may find that freeform editing shapes takes some getting used to, but 
with practice, you can make almost any shape you want! Same thing with 

editing curves – everyone accidentally makes abstract art the first few tries!
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YOUR TURN! EDIT A SHAPE
Follow the steps below to practice editing a shape.

1. Open a new PowerPoint 
presentation and create a shape  
with all lines and no curves, such 
as a star, triangle, or square.

2. After selecting your shape, 
s elect the Edit Points option 
from the Edit Shapes 
dropdown menu in the Shape 
Format tab (steps 1 - 5).

3. First, click and drag any of the edit 
points to modify one of the lines 
(steps 7 - 8).

4. Then, click any of the other edit 
points and use the two new lever 
points that appear to create a 
curved line (steps 7 - 8).

YOU’LL BE A SHAPES PRO BEFORE YOU KNOW IT!
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REFLECT ON WHAT YOU LEARNED

How can you apply what you learned in this section? Write 2 - 3 ideas.

What are some of your key takeaways from this section? Write any notes or 
tips you want to remember and any other thoughts from this section.

What are you struggling with or confused about? Record any questions you 
have about this section.
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IT’S SHAPING UP TO BE A GOOD LESSON
Now, let’s get into some true shape - building techniques.

Shape building is one of the simplest secrets in graphic design. Have you 
ever wondered how designers create those flashy, custom icons and how 
they seem to have an icon for every occasion? While shape building isn’t the 
only way, it’s one of the easiest and fastest!

Shape building is the art of combining simple shapes – like circles, squares, 
and triangles – to make all kinds of complex shapes that would otherwise 
take a lot of effort and skill to create.

While some illustration tools have more robust features, those available in 
PowerPoint have a wide range of uses and are likely enough for whatever 
project you have in mind!

1. Start by deciding what shape you’re trying to make.

This may seem like a silly step – of course you should know what
shape you’re making before you try to make it! But properly planning
a shape is one of the most important steps in the process.

In order to  build complex shapes, you have to  be able to break it
down into its simpler components .

Take this icon of this meter and cogs. While it looks like several difficult 
shapes to make, it could be easily recreated with shape building!

F76B1C

To break a shape into its simpler components, you have to  know what 
you want to build in the first place. For the purposes of this tutorial, 
let’s keep it simple: we’re going to create a rounded rectangle with one 
fully rounded side and one squared - off side.
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2. Make the simple shapes you need per the
steps in Section 1. In this case, we’ll make a circle
and a rounded rectangle.

3. Line up your shapes in the same way you want the final shape to 
appear after being merged.

You must be PRECISE  at this step – lining up your shapes cleanly now 
will ensure they merge exactly the way you want later! For instance, 
ensure no part of either shape is hanging off the outer edge.

TIP
You may find it helpful to make each 
shape a different color when lining 

them up – something unique from each 
other as well as different than the 

background color. This way, you can 
easily see where the edges of each 

shape are and where there is good or 
bad overlap. Another method of this is 
to make the shapes translucent so you 

can see where the overlap is. Still 
another method is to keep the outlines 
on the shapes. Play around with this to 

find the way that works best for you!
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4. Once your shapes have been placed where
you want them, you’re ready to merge them!
To do this, you must first select both shapes. Click one of your shapes.  
Then, hold the Shift key and click the other shape . This will highlight 
both at the same time – a bounding box will be visible around both.

NOTE
Where the shapes are on the slide isn’t important. Once you’ve created 
your final shape, you will be able to move it around, scale it, rotate it, or 

otherwise modify it the same way you did with single shapes (see 
Section 1, MAKING & PLACING A NEW SHAPE, for more details).

5. Click the Shape Format tab in the toolbar, which appears when you click 
the first shape.

Bounding Boxes Around Both

4.

5.

NOTE
This tab only appears when a 

shape is selected. If you aren’t 
seeing this tab, it means you 
either haven’t selected your 

shape per step 1, or you have 
selected a different item by 
mistake, such as an image.
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6. In the Insert Shapes panel, click the Merge
Shapes dropdown menu .

TIP
Hovering over each 

option will show 
you a preview of 

how it will combine 
or cut out your 

shapes.

7. You’ll see that there are several options for shape building here. Let’s 
look at what they each do.

A. TO COMBINE TWO SHAPES: To make the 
shape mentioned at the beginning of this 
Section – a rounded rectangle with one fully 
rounded side and one squared - off side – 
click the first option, Union . Both shapes will 
be combined into one . This is especially 
apparent if you have the outlines of the 
shapes turned on – you will see the outline on 
the two shapes change to an outline on one, 
signaling that the shape has been combined.

7A.

B. TO CUT OUT THE OVERLAPPING PORTION 
OF THE SHAPES: When you click the 
Combine  option, you’ll see that the portion 
of the shapes overlapping in the middle is 
cut out and deleted . This is especially 
apparent if you have something behind the 
shapes – you can see that the middle 
portion is now gone and what is underneath 
is now visible in the resulting hole.

7B.
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C. TO CREATE A SHAPE FROM THE 
OVERLAPPING PORTION & KEEP ALL 
THREE SHAPES: When you click the 
Fragment  option, it will at first appear as 
though nothing has happened; however, 
you will now have three shapes on the 
slide: the two original ones , plus a third 
for the portion of the shapes that was 
previously overlapping. This option 
punches out the overlapping shape but 
leaves all three shapes on screen.

7C.

D. TO CREATE A SHAPE FROM THE 
OVERLAPPING PORTION ONLY: When 
you click the Intersect  option, the two 
original shapes will disappear. In their 
place, only the overlapping portion  will 
be left behind.

7D.

E. TO DELETE ONE SHAPE FROM 
ANOTHER: This one can be a bit tricky 
because it depends on the order in 
which you select the shapes . When you 
apply the Subtract  option, PowerPoint 
removes the second shape you selected 
from the first one. The second shape 
disappears completely, and you’re left 
with only the portions of the first shape 
that were not overlapping it. So  
remember: the first shape stays (with a 
chunk removed), and the second shape 
is subtracted from it.

7E.

Selected Rectangle First

Selected Circle First
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8. Once you’ve built a shape, you can use it to
build more shapes  and so on.

A. For instance, let’s say we want to cut a star out from our rounded 
rectangle (made using the Union option from step 7a).

B. If we build a star on top of the new shape , we can use the 
Combine  or Subtract  option to punch out the star shape. You can 
see how the background is now visible within the star.

Selected Rectangle First

8A. 8B.

8B.

The possibilities with shape 
building are truly endless! Try 
out all different combinations 

to get all sorts of results!
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YOUR TURN! MERGE SOME SHAPES
Follow the steps below to practice merging shapes.

1. Open a new PowerPoint presentation 
and create any two shapes.

2. Line up your shapes in the same 
way you want the final shape to 
be merged. Make sure the shapes 
are overlapping each other in 
some way (step 3).

3. Select both shapes (step 4).

4. Using the Merge Shapes dropdown 
menu, merge the two shapes using 
any of the first four merge options – 
Union, Combine, Fragment, or 
Intersect (steps 7A - 7D).

5. Create a new set of shapes. 
Select them both, this time being 
careful to select one shape before 
the other depending on how you 
want them to be cut out (step 7E).

6. In the Merge Shapes menu, use the Subtract option, noting how the 
shape cuts out based on the order you selected them (step 7E).

YOU’LL BE A SHAPES PRO BEFORE YOU KNOW IT!
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REFLECT ON WHAT YOU LEARNED

How can you apply what you learned in this section? Write 2 - 3 ideas.

What are some of your key takeaways from this section? Write any notes or 
tips you want to remember and any other thoughts from this section.

What are you struggling with or confused about? Record any questions you 
have about this section.
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PICTURE THIS…
Sometimes rather than a shape, you may want to use an 
image as a decorative asset, manipulating its edges either 
to crop it into a particular shape or cut a shape out of it.

Let’s take a look  at how to do both!

F76B1C

1. CROPPING AN IMAGE INTO A PARTICULAR SHAPE

Cropping an image into a shape is especially useful for times when 
you want an image to appear inside a perfect square or circle, such 
as for a slide to introduce speakers in a presentation.

A. First, put the image you want to crop onto your slide. There are 
two ways to do this .

i. You can drag and drop the image  from your desktop folder 
onto your slide.

ii. You can also navigate to the Insert  tab, click the Pictures 
dropdown menu , and click This Device to find and insert your 
image that way.

1Ai.

1Aii.

Dragging 
Cursor
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B. Click your image to select it. You will know it’s been
selected when the bounding box appears around it.

C. After you click the picture, click the new tab that appears on the 
toolbar called Picture Format . The tab may automatically open 
upon clicking the picture.

NOTE
This tab only appears when a 

picture is selected. If you aren’t 
seeing this tab, it means you 
either haven’t selected your 

picture per step 1b or you have 
selected a different item by 
mistake, such as a shape.

D. In the Size panel, click the Crop dropdown menu .

E. There you will see several 
options. For this guide, we 
will cover two: Aspect 
Ratio and Crop to Shape .

1D.

1E.
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i. ASPECT RATIO CROP: This crop option allows you to choose a 
width - to- height ratio for your image. The 1:1 ratio is especially 
useful – it lets you crop an image
into a perfect shape (square, circle,
etc.) without any distortion. If the
proportions of the image don’t
matter, you can skip straight to
step 1eii.

1:1  Crop

ii. CROP TO SHAPE: This crop option allows you to turn the photo 
into any of the pre - formed shapes  in the dropdown menu.

a. Click the desired shape from the dropdown menu.

b. The picture will automatically be cropped to that shape 
using its current proportions (hence, if you want a 1:1 
shape or any other ratio, follow step 1ei above first).

Ratio of
Original Picture

1Eiib.

1Eiia.
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2. CUTTING A SHAPE OR TEXT OUT OF AN IMAGE
A. This process is the same as cutting a shape

out of another shape as covered in Section 5 of this guide,
USING THE MERGE SHAPES DROPDOWN.

B. To start, create the shape or text you want to cut out of the image. 
If a shape, modify it in size, dimensions, and rotation as needed 
(reference Section 1, MAKING & PLACING A NEW SHAPE, to see
the steps of this process).

C. Place the shape or text in the exact place where you want to cut 
out the image. Be sure it is properly lined up and sized, as this is 
exactly how the shape will be cut out.

NOTE
Where the shapes are on the slide isn’t important. Once you’ve created 
your final shape, you will be able to move it around, scale it, rotate it, or 

otherwise modify it the same way you did with single shapes (see 
Section 1, MAKING & PLACING A NEW SHAPE, for more details).

D. Select the image behind the shape or text FIRST. Then, hold the 
Shift key and select the shape or text SECOND so both items are 
selected. When you see a bounding box appear around both items, 
you will know both are selected.

NOTE
This order is 
EXTREMELY 

important. If you 
select the items in 
the opposite order, 

this process will not 
work correctly.

Selected First

+
Selected 
Second2B/2C.
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E. Because you have both a shape or text and a
picture selected, the Shape Format and Picture
Format tabs will appear in the toolbar. For this process,
click the Shape Format tab . To help you remember, this process
falls more into the realm of shape building – we are doing the same 
steps here as we did when shape building with two shapes – so 
therefore, we need the Shape Format tab.

F. In the Insert Shapes section, click the Merge Shapes dropdown menu .

G. Hover over each of the items to see which effect you want to 
create . For more information on each of the options, reference 
Section 5, USING THE MERGE SHAPES DROPDOWN.

i. In the case of cutting out text from an image, as in the 
screenshot below, the Intersect option works great!

2E.

2F.

2Gi.

As you can see, the options for what you can do are limited only 
by your creativity! There are many, many uses for this function – 

experiment to determine what works best for you!
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YOUR TURN! CROP AN IMAGE
Follow the steps below to practice cropping an image.

1. Open a new PowerPoint presentation 
and place an image on the slide
from your desktop (step 1A).

2. Choose an aspect ratio to crop 
the image to (step 1Ei).

3. Choose a shape to crop the image 
to (step 1Eii).

4. Place a second image on your 
slide from your desktop (step 1A).

5. Add a shape or text on top of the 
image. Be sure to line it up the 
way you want the final image to 
look (steps 2B - 2C).

6. Merge the image with the shape 
or text using one of the five 
options from the Merge Shapes 
dropdown menu (steps 2E - 2G).

YOU’LL BE A SHAPES PRO BEFORE YOU KNOW IT!
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REFLECT ON WHAT YOU LEARNED

How can you apply what you learned in this section? Write 2 - 3 ideas.

What are some of your key takeaways from this section? Write any notes or 
tips you want to remember and any other thoughts from this section.

What are you struggling with or confused about? Record any questions you 
have about this section.
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APPENDIX: THOUGHTS & NOTES
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JOT IT DOWN! THOUGHTS & NOTES
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APPENDIX: THOUGHTS & NOTES
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APPENDIX: THOUGHTS & NOTES
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APPENDIX: THOUGHTS & NOTES
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APPENDIX: THOUGHTS & NOTES
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